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Disclaimer  
 

Interactive Individual Identification 
System - Pattern version 4.1 

 
 
I3S Pattern is free software; you can redistribute it and/or modify it under the terms of the 
GNU General Public License, version 2 or any later version published by the Free 
Software Foundation. 
 
This manual is released under the terms of the GNU Free Documentation License, 
version 1.1 or any later version published by the Free Software Foundation. 
 
This program is distributed in the hope that it will be useful, but  
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY 
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for 
more details. 
 
You should have received a copy of the GNU General Public License and GNU Free 
Documentation License along with the distribution (COPYING GPL v2.txt and 
COPYING.DOC.txt) If one of these files is missing, write to the Free Software 
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA. 
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1 Introduction to I
3
S Pattern

+
 

1.1 What is I
3
S Pattern+? 

I
3
S is an acronym of Interactive Individual Identification System. I

3
S Pattern is an extension of the I

3
S 

system using any existing natural pattern on the animalôs body. This name explains most of I
3
S 

Patternôs functionality. First, we will focus on the interactive part. I
3
S Pattern requires user interaction 

and is meant to support and not to replace the researcher. Initially, you have to point out the relevant 
part of the pattern of the unknown individual animal. I

3
S Pattern has an automatic key point extraction  

algorithm which generates a unique fingerprint for each image. In the next step, I
3
S Pattern assists 

you in the tedious task of matching animals for identification purposes. It automatically matches an 
annotated image of an unknown animal with all annotated images in the identification database and 
shows a ranked list of images. However, you will always be responsible for making the final match 
between the unknown image and an image from the identification database. Please note that we 
distinguish between your database with all images taken and the identification database. The 
identification database contains only the best images of known individuals and preferably 3 to 5 of 
each individual.   
 
I
3
S Pattern

+
 is the fifth release in a series of related software tools. The first was I

3
S (now referred to 

as I
3
S Classic). This package is based on annotation of the spot centers and is used for animals with 

lots of similarly shaped spots such as whale sharks. The second package was named I
3
S Manta 

(now I
3
S Spot). I

3
S Spot focuses on animals with more variation in spot shape. Instead of annotating 

the centers only, spots are annotated by the closest fitting ellipse around each spot, in this way 
taking spot size and shape into account. The third package was I

3
S Contour, which used the contour 

of e.g. flukes for identification. The previous package was I
3
S Pattern. The user indicates the general 

area of interest and the key points are extracted automatically. 
 
Pattern

+
 was developed because we found that although amphibians often have very clear and 

unique belly patterns, the intensity of the pattern varies as the animal matures. I
3
S Pattern could not 

handle these variations reliably. I
3
S Pattern

+
 reduces the image to basically two values, i.e. 

background and foreground, or pattern and not pattern. This forces the algorithm to take only the 
shape into account and ignore intensity variations. 

1.2 How to choose a version? 

The table below indicates which version of I
3
S is most suitable for your application. 

 

Version Suitable for 

Classic Animals with very regular spots. If there is a large variation in spot size, you should 
use Spot. As this was the first version ever, probably you should always use Spot for 
spots. Classic is kept for the large group of users who started early. The only 
advantage of Classic over Spot is a slightly simpler and therefore faster annotation 
while Spotôs annotation will be (much) more accurate, especially with variation in spot 
shape. 
 

Spot If you have well defined spots which can be annotated consistently, you should use 
I3S Spot. 
 

Contour If the main feature is a contour or a line, e.g. fluke contour, or perhaps the dark/light 
transition on the flank of a shark, use this feature. 
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Pattern In some cases the features of an individual animal is such that it is not trivial to 
annotate consistently manually with the previous versions. In these cases you can use 
Pattern. Pattern will extract the key points for you. You only need to select the area 
and the three reference points. BE AWARE: Just because it is automatic, this does 
not mean Pattern is the best choice. Automatic key point extraction is susceptible to 
difficult circumstances like varying light conditions, water particles in front of the 
animal, etc. Proper manual annotation is still superior to automatic techniques 
provided that the manual annotation can be done consistently. 
 

Pattern
+
 This version should only be used if you can easily make an easy distinction between 

the pattern and the background. This requires either a clear difference in color 
between foreground and background, and/or very even lighting. For this reason, 
Pattern+ is currently most likely not suitable for underwater photos as the 
lighting is often very uneven. 
 
This is demonstrated with the image below. Due to the uneven lighting the dark spot 
on the top is in fact lighter than the light background pattern on the bottom. Pattern

+
 is 

currently not capable of handling these differences.   
 

 
 

 
In Figure 1-1 we show some examples which will be discussed below. 
 
Annotation of the whale shark (a) is done best with Classic or Spot. Traditionally Classic is used for 
whale sharks. As the spots are quite regular the advantage of using Spot is probably not large. As 
manual annotation is simple, you should not consider Pattern. 
 
In case of the manta ray (b) you should use Spot. Difficult light conditions and the frequent 
occurrence of remoras (hitchhikers) may yield inconsistent results with automatic key point extraction 
from Pattern. 
 
For the ragged tooth shark in (c) also Spot is the best option. In the very difficult visual circumstances 
(murky water, flash lighting up water particles) Pattern will be unreliable and only the human visual 
system will be able to annotate consistently. The variation is spot shape gives Spot an advantage 
over Classic. 
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(a) (b) 

 

  
(c) (d) 

 

  
(e) (f) 

 

Figure 1-1: Whale shark (a), Manta ray (b), Ragged tooth shark (c), Turtle (d), Humpback flukes (e) 
and Hong Kong newt (f). 
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Consistent annotation of a turtle (d) is quite difficult using either Spot or Classic. For this type of data, 
Pattern was developed. However, difficult visual circumstances (reflections, light variation, large 
angles) may yield inconsistent key point extraction. 
 
For the annotation of the trailing edge of flukes (e) Contour was developed. Contour only considers 
the trailing edge and does not (yet) take the patterns on the flukes into account.  
 
For clear and often colorful patterns many amphibians have, Pattern

+
 is ideal. The difference in 

colors makes it easy for I
3
S to separate background and foreground with a little input from the user. 

As amphibians often curve their bodies, you should also consider using I
3
S Straighten (see website) 

to pre-process the image and correct for this.  
 
We refer in the remainder of this manual to I

3
S Pattern

+
 as I

3
S.  

1.3 The algorithm 

 The reference points 1.3.1

To be able to correct for differences in viewing angle, rotation and scaling, the user is always 
required to point out three fixed reference points. The reference points should satisfy the following 
requirements: 
 
1. Their exact location is consistently and clearly distinguishable. 
2. Visible in all images. 
3. The triangle made up by the three reference points should cover most of the region of interest 

used for identification. Ideally the triangle should have angles of 60 degrees. In most cases this 
will not be possible, but you should try to get as close as possible for optimal results. 

 
Figure 1-2 shows the reference points used for a yellow-bellied toad. The left and right base of the 
belly and the tip of the head are indicated by red arrows. Do not mix-up these reference points as this 
will inhibit proper recognition. See section 4.1.3 if you want to change the names of the reference 
points. 
 
Each new species will require careful selection of the three reference points as this is critical for 
performance of I

3
S. If you want to use I

3
S on a new species you ae advised to consult the I

3
S team 

for support at i3s [at] reijns.com.  
 
 
 
 
 
 

 Image segmentation 1.3.2

Prior to the key point extraction, the image needs to be reduced to only foreground and background, 
or pattern and not pattern. The user points out several places in both foreground and background. 
The pixel values are used to train I

3
S to know the difference between pattern and the rest. As the 

intensity of the pattern may vary, it is important for the user to point out the variation as training. 
Typically, about 25 to 35 examples in total usually suffice. Figure 1-2 shows the pattern part of the 
image in green.  
 

! 
I
3
S offers the option to use only two reference points. WARNING: when using only two 

reference points I
3
S can only correct for scaling and rotation. When your viewing angle is not 

perpendicular, I
3
S will need three reference points to be able to correct for this. 
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 Key point extraction 1.3.3

To help recognize individual characteristics I
3
S automatically extracts all key points within a region of 

interest indicated by the user. The region of interest is the area in the image used for identification. 
Each key point has a size and location. The image should be taken ideally perpendicular to the line 
of sight and no more than 30 degrees off that line. To make sure that I

3
S focuses on the general 

pattern only, the users indicates which pixels are pattern and which are not pattern. With this input 
generalizes this to the entire image, effectively reducing the image to a two value (binary) image. 
Each pixel is either pattern or not pattern.  The algorithm for automatic key point extraction uses the 
OpenCV (http://opencv.willowgarage.com/wiki/) implementation of the SURF features 
(http://www.vision.ee.ethz.ch/~surf/). Image segmentation is based on Support Vector Machine 
software from OpenCV to learn the distinction between pattern and not pattern from the pixels 
selected by the user.  
 
Once the key points are extracted, the collection of key points is stored in what is called a ófingerprint 

fileô. You recognize these files by the extension .fgp . In the identification step, the resulting key 

point pattern is matched with the patterns of all the known images in the identification database. 
 

 

Figure 1-2: Yellow-bellied toad (Bombina Variegata) with the three reference  
points (indicated by red arrows for clarity) the selected belly pattern in green,  

and the automatically extracted key points. 

http://opencv.willowgarage.com/wiki/
http://www.vision.ee.ethz.ch/~surf/
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 Key point comparison 1.3.4

With the reference points selected it is now possible to correct for rotation and scaling and compare 
two images in roughly the same 2D recognition space or coordinate system. A comparison of two 
images comes down to finding corresponding key point pairs in the above-mentioned coordinate 
system. In the current implementation a key point pair is accepted as a good match if the nearest 
other candidate is at sufficient distance from  the current match. Further, the key point sizes should 
be sufficiently similar. Figure 1-3 shows the (centers of the) key points of two different images of the 
same individual in this coordinate system. The red circles denote the key points of the first image 
while the blue circles represent the key points of the second image. The green lines indicate whether 
two key points are considered a matching pair. From these pairs a distance metric is calculated to be 
able to rank each image in the database. The current metric is the sum of the distances between 
each key point pair, divided by the square of the number of key point pairs. When comparing two 
fingerprints I3S may generate thousands of potential ways to map the two fingerprints onto each 
other. Only the best mapping is used. Further, differences in key point size will also affect the final 
score. The larger the differences in sizes the higher the score (where a lower score indicates a better 
match). 
 

 

Figure 1-3: Comparison of the key points from two images of the same individual. 

 
Obviously, there are some limitations to this approach. 2D linear transformations work best for 2D 
linear animals, which do not exist. However, this approach has proven to be effective if some 
constraints are considered, i.e. view angle to the area of interest does not exceed 30 degrees, the 
body area used for identification is not (very) susceptible to curvature (or it is possible to correct for 
curvature using I

3
S Straighten) of the body and consistent annotation of the reference points is 

possible. For a more detailed discussion on the practical issues you are referred to Chapter 6. 
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For details on the original algorithm, you are referred to our paper: A computer-aided program for 
pattern-matching natural marks on the spotted raggedtooth shark Carcharias taurus (Rafinesque, 
1810), A.M Van Tienhoven, J.E. den Hartog, R.A. Reijns & V.M. Peddemors, Journal of Applied 
Ecology 44, 273ï280 (2007). For specific details on the implementation, please contact the I

3
S team 

by email or have a look at the source code delivered with the distribution. 

1.4 I3S Version numbering 

Version numbers are related to the baseline of general software. The current version is version 4.1.  

1.5 I3S Updates 

I
3
S will automatically check for updates and new releases. This is part of all I

3
S software packages 

version 3.0 and higher. Every 30 days, upon start-up of I
3
S, it will check for updates. If an update is 

available, it will ask you if it should download and install a new version. After each update I
3
S will ask 

if you want to see the release notes on the website. 
 
 

 

Figure 1-4 Update check. 

 
Please note that downloading and installing updates only works in Windows Vista or higher if User 
Account Control is turned off and if you have sufficient rights. UAC prevents I

3
S to copy files to 

protected locations such as C: \ Program Files  even if you have administrator rights. You can 

manually set this parameter via the Control Panel on your computer.  

1.6 Reading this document 

In this document all file names, directory names and shell commands are written using the font  

Courier New . All names relating to a part of the I
3
S user interface, such as button names or menu 

options, are boxed. If a message is particularly important the margin will show a large red boxed 

exclamation mark.  

1.7 Bug reports, comments and requests 

Please send all bugs, comments and questions to i3s [at] reijns.com. In case of a bug, describe 
clearly how we can reproduce the bug ourselves. If possible provide us with all relevant data such as 
images and fgp-files. We will always treat your data as confidential. Data will not be distributed to 
others without your explicit consent.  
 

An error log file will be written in the _ErrorLogs  directory in your database directory when internal 

errors are reported by the software. Please send this file (or files) to the I
3
S team along with any bug 

report. 

http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
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2 Installation of I
3
S Pattern

+
 

2.1 System requirements 

This version of I
3
S requires a Windows 32-bits or 64-bits operation system 

(XP/Vista/Windows7/Windows8). The software has not been tested on Windows 10 yet but most 
likely it will work on this platform as well. The software is developed using Java 1.8 and C++ (MS 
Visual Studio C++ 2013). Both Java and most of the C++ code are platform independent and it 
should therefore be relatively simple to port it to other platforms such as Linux or Mac OS. OpenCV 
is available under all common platforms.  
 
Hardware requirements are at least 2GB of memory (preferably 4 GB or more), and a 2 GHz CPU or 
faster. Increase of the identification database to hundreds of images will increase the preferred 
requirements on CPU speed but will have a limited impact on the memory requirements. Comparison 
is linear in computational requirements, i.e. an identification database with twice the number of 
individuals will require twice the time to compare with. 
 
I
3
S is implemented to use multiple cores when comparing with the database. In the user settings you 

can control the number of cores used.  

2.2 Software and data requirements 

Because the main program is developed in Java, the Java Run-time Environment (JRE) is required. 
This distribution will only work with a 32-bits JRE version 1.8.0 or higher! The JRE 8 (or higher) 
can be downloaded for free from the Java website (http://www.java.com/en/download/manual.jsp)  
and download version Windows x586 Offline). 
 
Note: I

3
S currently only works with the 32-bits version of the JRE. I

3
S has been developed on a 64-

bits version of Windows 7, however with a 32 bits JRE. If a 64-bit JRE is used, I
3
S will report an error 

at start-up of the program. 
 

I
3
S supports both JPEG (extension .jpg ) and GIF (extension .gif ) images. Support of other image 

types is currently note foreseen as all known digital cameras can store images as JPEG. 

2.3 Installation 

Make sure you have administrator rights and turn User Account Control (UAC) off. UAC prevents the 
proper installation of the Windows environment variables. 
 

Run the file I3SP P_v4. 1_Setup.exe . If your current Java version is not sufficient you will be 

notified and installation terminates. It is required to install the Java Runtime Environment 1.8.0 (or 
higher) first.  
 
Apart from some information about the GNU-license, the installation consists of the following steps: 
1. Choosing the home directory where to install the program. Default will be in the directory  

C: \ Program Files (x86) \ I3SP P. 

2. Choosing whether you want to store an example data directory with image and fingerprint files.  
3. You can indicate if you want I

3
S to create a folder in the Start menu folder.  

4. Finally, you can select some additional tasks: 
a. Creating a desktop item. 
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b. Copy tutorial examples in the data directory. 
c. Copy the source code. Only if you are interested in using or changing the source code 

you need to check this item. 
5. If you selected to copy the tutorial images, you will be asked for the location. Please do not store 

the data in the C: \ Program Files (x86) directory or one of its subdirectories as this may 

result in errors while using I
3
S. Choose another location such as C: \ MyData . 

 
Because an environment variable has been added you are asked if you want to restart the computer 
now or later. I

3
S will not work properly until you restart the computer or logout and login again. 

 
If you want to install I

3
S under another account, this is possible. At start-up the application will search 

for the I3SP P_INSTALL  environment variable which has as value the directory where I
3
S is 

installed. The default location is C: \ Program Files (x86) \ I3SP P. The installer creates this 

variable in the HKEY_LOCAL_MACHINE section of the registry which means that it is available for all 

users. If this variable is not found, the application terminates. At the first start-up by another user just 
select an existing database or create a new database. 

2.4 Norton security alert 

After starting I
3
S you may get an alert from Norton Anti-Virus that it has detected malware. Typically it 

will mention that it has found a threat called ñSuspicious.Cloud.7.EPò. This is absolutely a false 
alarm. If you google on ñNorton suspicious cloud false alarmò you will find many hits about other 
false alarms. Norton says on their forum the following about this alert:  
 
 

ñSuspicious.Cloud.7.F is one of our heuristic detections.  What this means is it's not a true 
virus, but rather one of our technologies that tries to detect new (aka "zero-day") threats.  It 
looks at a number of attributes and behaviors that we've identified as common in existing 
threats.ò   

 
 
The only way to solve this annoying issue is to tell the Norton application to restore the file and 

ignore this file in future scans. Norton has given false alarms on openCV dllôs and i3ssurf.dll . 

2.5 Uninstall 

You can uninstall I
3
S in two simple steps: 

 
1. Uninstall I

3
S, using the entry in the start menu folder. 

 
2. Optionally you can also uninstall the Java Runtime Environment (JRE). In general it is not a good 

idea to uninstall JRE without replacing it for a newer version because other programs may 
depend on it. However, if you still want to uninstall JRE use the standard procedure: Select 
Programs and Features  in the Control Panel. Then select the appropriate item from the list and 
click on the Add/Remove button.  

2.6 Quick introduction with video tutorials 

Examples are shown in our instruction videos. These video tutorials are available online at YouTube. 
Search in YouTube for ñI3S channelò. The links to these videos are also available at the website and 

via the Help menu. Many of the videos for I
3
S Classic and I

3
S Spot apply as well to I

3
S Pattern

+
. Only 

the annotation is different, but searching, defining metadata, etc. is identical for all versions. 

! 
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3 Data management 

3.1 Introduction 

I
3
S compares unknown images with an identification database consisting of a collection of image-

fingerprint pairs.  In this document, with the term óidentification databaseô we mean: a structured 
directory containing the collection of all known images used for reference by I

3
S. Possibly you will 

have another database or collection of either known or unknown images, but that is considered an 
entirely different database. 
 
A fingerprint file containing all information added in the annotation process accompanies each image 
file. Always treat these images as an inseparable pair. If you move one of the files manually to 
another directory you should always move the other file along. 
 
Earlier versions of I

3
S only allowed one identification database. At installation the user had to select a 

specific directory where the data was stored. Multiple identification databases (either other types of 
animals or other locations) where not supported and resulted in the need to rename and swap 
database directories.  
 
I
3
S Pattern

+
 allows you as many identification databases you need. The locations of data directories 

are stored at an individual level (specific: in the registry in HKEY_CURRENT_USER), so it is possible to 

have multiple users using the same pc or laptop and manage their own databases as well as 
manage shared databases. 
 

All database management is found under the menu item Database, see §4.1.3 for details on their 

use. 

3.2 I3S management tools 

I
3
S offers the following tools for data management: 

 
1.  Search in database Compare an annotated image against the entire identification 

database and show a ranked list of results. The lower the score, 
the better the match. 

2.  Insert in database Add an annotated image to the identification database. Either add 
it to an existing individual or insert it as the first image of a new 
individual. 

3.  Reload database In case you have manually added or removed files to the 
identification database directory you can reload the current 
database to incorporate the changes. 

4.  Change database Load another database from the list of known databases. 

5.  New database Start a new identification database and add it to the list of known 
databases. 
 

6.  Rename database Rename an existing database directory. 
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7.  Edit database list Remove a directory from the list of known identification databases 
or add a directory. The latter is used to add an existing 
identification database. 

8.  Edit metadata Edit the metadata structure of the current identification database.  

9.  Batch compare If you have a large batch of new photos, e.g. collected at a field 
trip, and you do not want to wait for the time to compare each 
annotated photo against the database, this option is useful. Just 
put all annotated photos in a single directory and let I

3
S process 

all at once. You can read in the results and process the data 
without waiting for comparison later. 
 
Further, if you want to compare two databases, e.g. to establish 
whether individuals migrate between locations, batch comparison 
allows you to find the best matches with almost no manual 

interaction. The results are written to an MS Excel readable csv  

file. 

10.  Process batch results Process the results in the file resulting from batch compare. For 

each compared image a search window with the results is shown. 

11.  Process meta data For correction or filling the meta data settings of the entire 
database. All database members will be visited and you can 
change meta data settings. The files in the database can be 
limited to those files with missing meta data fields. 

12.  Recreate thumbnails Thumbnails are used to show the found results efficiently. You can 
affect the way these thumbnails are created. This option allows 
you to recreate all thumbnails in the current database when 
settings for creation of the thumbnails have changed. 

3.3 The database directory 

All data in an identification database is structured by means of a directory tree. For each individual, 
the corresponding images are stored in a separate subdirectory in the identification database. Each 
image is described by its key points and by means of metadata fields stored in the fingerprint file with 

extension .fgp . In older versions of I
3
S, the sex and various views where stored by means of 

subdirectories under the subdirectory for the individual. Starting with v3.0, sex and views are covered 
by the metadata structure. You are required to define this yourself.  
 
The top-level directory of an identification database contains for all known individuals a 

corresponding directory, the file metadata.xml , a directory named _ErrorLogs  for error reports by 

the software, and an optional directory _SearchResults  with the outcome of the various searches 

and evaluations.  
 

For example: 
 

Directory Description 
C: \ I3S \ NewtData  Top-level directory. It contains directories for the individuals 

Jimmy , Ronald , George  and Bill  and the directory 

_ErrorLogs . 



I
3
S Pattern

+
 Manual, v4.1  January 2016  

 
 
 

17 

C: \ I3S \ NewtData \ Jimmy  This subdirectory contains image and fingerprint files 

Jimmy001.jpg , Jimmy001_thmb.jpg , Jimmy001.fgp , 

Jimmy002.jpg , Jimmy002_thmb.jpg Jimmy002.fgp . 

C: \ I3S \ NewtData \ Ronald  This subdirectory contains image and fingerprint files 

Ronald.jpg , Ronald _thmb.jpg Ronald.fgp , 

Ronald2.jpg , Ronald _thmb.jpg, Ronald2.fgp, 

DSC_00261.jpg , DSC_00261_thmb.jpg  and 

DSC_00261.fgp .  

 
The subdirectories for individuals should only contain image files and fingerprint files (extension 

.fgp ). Other file types are ignored. The image files should be of type JPEG (extension .jpg  or 

.jpeg ) or GIF (extension .gif ). Each fingerprint file corresponds with the identically named image 

file (apart from the extension). A fingerprint file contains all the pattern and extra information of the 
corresponding image file. The sample identification database provided with the distribution contains 
several individual newts (i.e. subdirectories). 
 
I
3
S will automatically create a thumbnail image for each annotated original image. The thumbnail 

images have _thmb  added to their name. 

 
 
 
 
 
 
 
 
At start-up, I

3
S looks up the list of known databases. In case the list contains only one, this database 

is loaded directly. If the list is empty, you have to create a new identification database first or select 
an existing database with a browser. In case the list contains more than one, you are asked to select 
a database from a list. After selection, the application starts to parse all the fingerprint files in the 
corresponding individual subdirectories. All fingerprint files are stored in memory for quick future 
reference during execution of search tasks. Since the fingerprint files are quite small (usually a few 
kilobytes) the memory use of the database will be limited. 

3.4  Metadata 

Each identification database has its own metadata definition. For example it is possible to define 
metadata fields to indicate length, size, sex, scars, or whatever you want to define for an individual. 
When searching the identification database, it is possible to search on the metadata as well. The 

exact metadata definition is stored in the file metadata.xml  stored at the top of a database 

directory. It is strongly advised not to edit this file manually but to use the graphical interface provided 
by I

3
S for this purpose. 

 

I
3
S currently supports four types of metadata fields: number , smallmediumlarge , yesno  and 

Custom . The number format will accept any number such as 0, 12, 4.2 and -5. The type 

smallmediumlarge  is a variable with three possible values (small, medium and large). Analogous, 

the yesno  type is a Boolean variable with values yes or no. Custom  lets you define a discrete and 

limited set of values yourself. 

Do not add extra directory levels as these will not be parsed!! An example of a directory 
which contents will be ignored: 
 

C: \ I3S \ NewtData \ Ronald \ Field trip 2013 \   

 
! 
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3.5 Error checking on the database 

If you manually change the database, e.g. by moving around files or directories, you might introduce 
errors. I

3
S will check for some errors when parsing the database. The checks performed by I

3
S are: 

 
1. Does each fingerprint file has a corresponding image file in the same directory? This error 

typically occurs if you move the image file but forget the fingerprint file or vice versa. 
2. Does each annotated image file has a thumbnail image? If not it is created automatically. 
3. Are there subdirectories within individual directories? A warning is generated that the 

contents of these directories are not parsed. 
 
If there are errors found a pop-up window is generated. A description of all problems found is written 

to the file db_errors.txt  in the _ErrorLogs  directory of the database. 
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4 The I
3
S user interface 

This chapter will address the possibilities of the I
3
S user interface. First, the menu bar and toolbar are 

described. Next, the interaction with the annotation panel is discussed. 

4.1 The menu bar 

I
3
S offers a standard Windows look & feel menu-based interface to perform most operations. In the 

paragraphs below, the six menu items will be explained. An overview of the title and menu bar is 
shown in Figure 4-1. The title shows the application name version and some details about the 
database: name, type and between brackets the number of fingerprints and individuals in the 
database. 
 

 

Figure 4-1: The I
3
S menu bar. 

 The File menu 4.1.1

This is the main I
3
S menu. Figure 4-2 shows the various operations, which are discussed below: 

 

 

Figure 4-2: the file menu. 

 

¶ Open image (shortcut CTRL+O). It will open a window to choose an image file. The supported 

image types are JPEG and GIF. The starting directory will be the top level directory of the 
selected database. If an image file has a corresponding fingerprint file (i.e. the same name but 

extension .fgp ) a turtle logo is shown, a standard image logo otherwise. The logos are shown 

below: 

  (with .fgp )   (without .fgp ) 

 

¶ Save fingerprint (shortcut CTRL+S). If you have annotated an image this operation will write a 

fingerprint file in the same directory as the corresponding image together with any metadata. 

Apart from the extension, which is .fgp , the name will be identical to the name of the image file. 

 

¶ Close image. It closes the image in the main window. If you have unsaved data I
3
S will prompt 

you whether you want to save the data first. 
 

¶ Print image (shortcut CTRL+P). It will print the current image including comments (see §4.2). 
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¶ Rename image. It will rename the image and its fingerprint file.    

 

¶ Exit (shortcut CTRL+X). This operation will close all windows. In case of unsaved data I
3
S will 

prompt you whether you want to save the data first. 
 
 

 

Figure 4-3: The edit menu. 

 The Edit Menu 4.1.2

¶ Undo and Redo are completely analogous to standard Windows functionality. The last 500 edit 

actions are kept in memory (Shortcuts: CTRL+Z and CTRL+R). 

 
 

 

Figure 4-4: The database menu. 

 The Database menu 4.1.3

¶ Search in database will compare the current image with the rest of the identification database. 

See Chapter 5 for details. 
 

¶ Insert in database In case of a loaded and annotated image, selecting this operation will allow 

you to add a new animal (i.e. a new subdirectory) to the identification database. This operation 
pops up a new window first that will prompt you for the name of the new animal. Selection of the 

checkbox Rename file will allow you to change the name of the image. By pressing Ok the image 

and its fingerprint file are copied (not moved) to the appropriate directory in the identification 
database. The figure below shows an example. If the file has been renamed, you are asked 
whether the original file needs to be renamed as well. 
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Figure 4-5: Insertion in the identification database. 

 

¶ Reload database If the identification database has been changed, i.e. fingerprint files have been 

manually added or removed using e.g. Windows explorer, this operation will reload the entire 
database. You do not have to call this operation after insertion of a new animal in the 
identification database. In this case, I

3
S will reload the database automatically. 

 
 

 

Figure 4-6: Changing the database. 

 
 

¶ Change database If you have multiple identification databases it is possible to load another 

identification database without exiting the application. This menu option will offer you a list to 

choose the database. Choosing the current database is identical to Reload database. Before 

changing the database, open files are closed and/or you are asked whether to save first. 
 

¶ New database If you want to create a new identification database choose this menu option. First, 

you are asked to select a new directory, either by typing it in at the text field Folder name or 

selecting the Create new folder button. Figure 4-7 shows the window. When you nevertheless 

choose an existing directory, the application will ask to create a new directory within the chosen 
one. After selecting a new directory, you are offered the window shown in Figure 4-8. Use this 
window to specify the database name. Type in a concise name as it is also shown in the top of 
the main application window. You can also change the description of the reference points. 
Further, it is possible to add a number of metadata fields to the identification database.  

 

¶ Rename database This option allows you to rename the directory of an existing database. First, 

you are asked to select an existing database, and then to type in the new name. Only letters, 
digits and spaces are allowed. After renaming, you are asked whether you want to change to this 
database. 
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Figure 4-7: The first step in creating a new database, directory selection. 

 
 

 

Figure 4-8: Setting-up the database (non-expert mode). 
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Figure 4-9: The window to edit the database list. 

¶ Edit database list If you want to remove an old database from the list of known databases or 

add an existing database directory you can use this option. Figure 4-9 shows the 

corresponding window. Remove deletes the selected directory from the list but it leaves the 

files in the map untouched. Add lets you select an existing directory and adds it to the list 

without checking whether it is a valid identification database directory (this will happen when 
the database is actually loaded). 

 

¶ Edit metadata This option allows to edit the metadata fields for the current database. Figure 

4-10 shows the window. 
 

The red numbers 1 to 7 indicate some important aspects of this window: 
 
1. The field database name defines the name which is shown in the title of the application. 

Press the button  to alter the name. When editing a field, it is not possible to select 

other buttons, except Cancel or  again to save the result. 

2. Names of the three reference points. 
3. Option to choose between two and three reference points. Use these buttons to switch 

between two and three reference points. WARNING: only choose two reference points if 
you control the situation in which the photo is taken, and you can photograph each and 
every individual exactly under a 90 degree angle. An example of such a situation is a 
small amphibian species which is taken out of the habitat prior to taking the photograph. 
Choose three reference points in all other cases, otherwise I3S will not be able to 
compensate for photos taken under an other than perpendicular angle. Select the number 
of reference points prior to annotation. Otherwise, you might need to redo the annotation 
of the reference points in your entire database. 

4. The expert settings are only available in ñexpert modeò (see also paragraph 4.1.5). The 

 will show a pop-up window explaining each variable. These variables are used for fine 
tuning the key point extraction and recognition algorithms. You are also referred to 
paragraph 6.6. Editing some of the variables will require automatically redoing the key 
point extraction. I

3
S will warn you when this is required. 

5. Use the left column of buttons to edit the names of the metadata elements. 
6. Press the button  to remove the field.  
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7. Press the button  to edit the names of the custom field type. This button is only 
available for type custom as only this type allows you to define a list of possible values, 
as is shown for type ósexô. When pressing this button the window is enlarged to show the 
fields to edit the possible values as shown above. All other elements are greyed out, 

except for Cancel and the buttons to edit the fields for the custom element. The minimum 

number of values must be two, the maximum is limited to 10. Close editor stores the list 

of values (if valid) and returns the window to the previous state. 
 

  

Figure 4-10: The window to edit the metadata (expert mode). 
 

1 
2 

3 

4 

5 6 

7 
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¶ Batch compare. With this option you can compare a directory with annotated images directly 

with the identification database. This feature might be useful if you have a large batch of new 
photos, e.g. collected at a field trip, and you do not want to wait for the time to compare each 
annotated photo against the database. Another application is to compare two databases to 
determine whether there is overlap in individuals to establish migration patterns.  
 

The results are written to an MS Excel readable csv  file in the _SearchResults  directory of 

the current reference database. After selecting Batch compare the window shown in Figure 

4-11 pops up. Choose the directory with your annotated new data and I
3
S will start with 

comparing each photo against the database. A progress bar keeps track about the time still 
required. After finalization a message is shown where the data is written. Use the options 
menu to specify how many of the best matching results are written to the batch results file. 
 

 

 
 

 

Figure 4-11: The window to choose the batch directory (top) and the message  
confirming the export of all results to the csv file. 
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¶ Process batch results. This menu item allows you to process the results from the batch 

compare. Each compared image pops-up together with a standard search result window 
(paragraph 5.2). 

 

¶ Process metadata. Often users forget to annotate the metadata in the fingerprints. This 

option allows you to process the metadata of all fingerprints. At the start the you are asked 
whether the selection should be limited to those fingerprints with missing metadata. 
 

¶ Recreate thumbnails. Thumbnails are used to show the found results efficiently. You can 

affect the way these thumbnails are created (see also the next paragraph). This option allows 
you to recreate all thumbnails in the current database 

 

 The Tools menu Ą Option results 4.1.4

Options results will pop-up the left window shown in Figure 4-12.  

 

The first part Logging results of the left options window concerns the automated logging of the 

searches performed. If logging is on, the outcome of each search will be written to a file in the 

database directory (subdirectory _SearchResults ). 

 

The naming of the file is SearchResults__ <date>_<time>.log . For example, a search on the 

second of July 2013, at the time of 17:22:10 will be written to the file named 

SearchResults__20130702_172210.log . The content of the log file is identical to the results in 

the search results window. Each line contains a filename and the score separated by tabs. Excel can 
process this format. 
 

File or folder in results window will determine whether the results window will show the last directory 

of a matching file, or the filename itself. If you choose the filename, please make sure each filename 
identifies the individual by name or code. 
 

The third part All or best individual match is used to choose between showing all matching files in the 

database or just only the best file from an individual directory. 
 

Show results can be used to indicate whether you are interested in the top 50 of best matches or the 

entire identification database. This choice will affect both the logging and the search results window. 
 

Number of batch results determines how many matches are shown when batch processing. For 

example, each time an unknown fingerprint from the batch directory is compared against the 
database only the top number of matches is stored. 
 

The next option, Result window size, gives a choice on a scale of 1 to 5 (tiny, small, medium, large, 

and as big as possible) how big the result windows will be. Bigger screens allow for bigger windows, 
making it easier to see directly whether two images are of the same individual. 
 

Finally, Focus results on annotated area, determines whether the thumbnails only show the 

annotated part or the original image, or anything in between. If your images are zoomed out and only 
a small part of the image actually shows the recognition area, this setting can create thumbnails (and 
therefore show results) which are focused on the relevant part of the image. Changing this setting 
requires recreating all thumbnails in the database which will be carried out directly after closing the 
options window. Recreating of a thumbnail may take a few seconds depending on image size and 
your computer.  
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If you have multiple databases, you will need to recreate the thumbnails for those databases as well 
(see previous paragraph how to do this manually). 

           

Figure 4-12: The two option windows. 

 

 The Tools menu Ą Options general 4.1.5

Options general will pop-up as the right window shown in Figure 4-12.  

 
The first part determines whether I

3
S is in expert mode or not. When in expert mode, the expert 

menu is shown, while editing the metadata shows more options. 
 
The second part allows you to choose the interaction with respect to updates. When choosing 

Automatically check for updates the software will check periodically without interaction. Only when an 

update is found you will be asked whether you want to install. Ask to check for updates will make 
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sure I
3
S gets permission before an update check. Never check for updates will make sure I

3
S never 

bothers you about updates, unless you manually choose Check for updates from the help menu.  

 

The third part named Drawing settings allows you to select various settings such as colors to use for 

the annotation elements. This can be particularly helpful if the species under study happens to show 
colors similar to the default colors used or if you are color blind. 
 

The final part named Number of threads to use determines how much I
3
S may use of the parallel 

processing capabilities of your computer. Default is 1 thread. If you increase this number, recognition 
speed will increase as well, however, other tasks carried out in parallel may also become slower (e.g. 
word processing, Excel, etc.). Experiments indicate a maximum speed-up of 3 compared to a single 
thread (see §6.2 for details). Any time you can set this level to the desired value. 
 
 

 

Figure 4-13: The expert menu. 

 The expert menu 4.1.6

This menu item is only available when expert mode is chosen with the Options general menu under 

Tools. See also the previous paragraph. This menu offers four options: 
1. Simple evaluation. 
2. Elaborate evaluation.  
3. Redo database. 
4. Redo individual. 

 
 
 
 
 
 
 
 
Simple evaluation 
This option is used to get an indication how good the various instances of the same individual match 
with each other, and whether I

3
S can be used for matching a certain species. All fingerprints in the 

database are compared with all other fingerprints. If a match between two instances of the same 
individual yields a score outside the top 10 of best matches this is logged. After the entire database is 
matched with itself, an overview is produced which may look like this: 
 
Simple evaluation results   
# intra individual comparisons: 210  The number of comparisons between finger-

prints of the same individual. For example, in 
a database with 10 individuals and 3 
annotated photos per individual, this number 

If you have multiple regions of interest per individual, e.g. left and right side photos of the same 
individual, make sure to put them in different directories before doing the evaluation. For example, 
make two different directories for Newt73: Newt73_Left and Newt73_Right. Otherwise, the 
evaluation tool will count mismatches between right side photos and left side photos incorrectly as 
errors (the evaluation tool does not consider the metadata). 

! 
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will be 60 as each of the 30 fingerprint has 
two possible matches. 

Accu mulated ranking score:      1218  For each comparison between two 
fingerprints of the same individual, the found 
ranking is added to a total. If the match 
between two such fingerprints results in a 
15h place in the total ranking, the total is 
increased with 15. 

Best possible (ideal)  score:   273 This is the best score theoretically possible. 
In the database with 10 individuals and three 
fingerprints per individual, each of the 30 
fingerprints ideally has its two other sibling 
fingerprints ranked 1 and 2. In this case, the 
ideal score would be 30x1 + 30x2 = 90. 

Evaluation took 13 seconds (3,98 msec 

per comparison, 3306 comparisons).  

Some statistics about the total number of 
comparisons and the time required. 

Top #1:  133(63,33%)  The top #X defines the number and 
percentage of comparisons resulting in a 
ranking in the top X of results. 

Top #2:  174(82,86%)  
Top #3:  186(88,57%)  

Top #5:  189(90,00%)  
Top #10: 195(92,86%)  
Top #20: 199(94,76%)  

 
The results of the evaluation are written to a file in the database directory (subdirectory 

_SearchResults ). The naming of the file is EvaluationResults__<date>_<time>.log .  

 
Elaborate evaluation 
Elaborate evaluation simulates a realistic scenario. After selecting this menu option, the window in 
Figure 4-14 is shown. The user can select the number of iterations and the number of reference 
images. Next, I

3
S basically separates the database in a reference set and a test set. From each 

individual directory, the specified number of reference images is randomly selected and added to the 
reference set. All remaining images are added to the test set. Next, each test image is compared 
against the reference set. Statistics are kept about the number of times the right reference image 
shows up in the top 1, 2, 3, 5, 10 and 20.  
 
The output may look like: 
 

Elaborate evaluation results  

1000 repetitions, 1 reference image. #refs: 78  #test: 85  

 

Expert settings   NrElements: 50   WarpSize: 500.0   RelKeypointDist: 

0.1   GrayConversion: [0.0,0.4,0.6]   MaxAllowedDist: 0.01  

Filling the matrix: 515 seconds  

Random iterations:  50 seconds  

 

Top #1:  72963 (85,84%)  

Top #2:  7 6926 (90,50%)  

Top #3:  77773 (91,50%)  

Top #5:  79373 (93,38%)  

Top #10: 81051 (95,35%)  

Top #20: 81273 (95,62%)  
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On this specific database of 163 images, using 1 reference image per animal, gives 91,50% 
probability that when comparing a new image of an individual already in the database, the proper 
individual is found in the top 3.  
 
More reference images will in general yield better results. However, more reference images will make 
the set of remaining test images smaller, which could result in less significant experimental results. 
 
Because the distinction between reference and test images is based on random selection, you need 
to repeat the process a lot of times to average out any random effects. The iteration parameter 
determines the number the process is repeated. The default value is 100. A 1000 iterations will 
require more time, but because of a pre-processing step, 1000 iterations will require relatively little 
more than the time needed for 100 iterations. 
 

 

Figure 4-14: The elaborate evaluation window. 

 
Evaluation of the database may be very time consuming. A good indication of the time required is the 
time needed for a single comparison against the entire database x the number of fingerprints in the 
database. During processing you can change  the amount of CPU power used by the evaluation 
process by adjusting the slider towards óslowô or ófastô. Faster evaluation might make other 
applications less responsive. 
 
Redo database 
In case the algorithm to automatically extract the key points from the region of interest is changed, 
this requires recalculation of all fingerprints in the database. Redo database will do this. See §6.6 for 
an explanation why this might be needed. From each fingerprint in the database the reference points 
and the region of interest are kept, only the key points are re-extracted. Before redoing key point 

extraction the metadata.xml  file is reread.  
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Redo individual 
The key points are now only re-extracted for the current image and fingerprint. 
 
 

 

Figure 4-15: The Help menu. 

 The Help menu 4.1.7

 

¶ Open manual will start your default PDF reader and open this manual. 

 

¶ Check for updatesé will check if there are updates. If an update is available you will be asked 

only once to install at the next start-up of I
3
S, even if update checking is disabled. For successful 

installation Windows User Account Control has to be turned off. 
 

¶ Go to the I3S website will open your default web browser and show the I
3
S website. 

 

¶ Video tutorials at the I3S YouTube channel will open your default web browser and shows the 

start page of the I
3
S channel at YouTube. 

 

¶ Follow us on Facebook will open your default web browser and shows the Facebook page of I
3
S. 

 

¶ About I3Sé shows a window with information on version number, authors, copyright and contact 

details.  

4.2 The tool bar 

Below the menu bar I
3
S shows a tool bar, which offers short cuts to functions described in the 

previous paragraphs and some new functions. An overview of the tool bar is shown in Figure 4-16. 
 

 
 

 

Figure 4-16: The tool bar (top: left half, bottom: right half). 

 
The table below describes the various items in detail. 
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Open file. Button for the menu option described in §4.1.1. 

 
Save file. Button for the menu option described in §4.1.1. 

 
Print file. Button for the menu option described in §4.1.1. 

 
Search. Button for database search described in Chapter 5. A 

keyboard shortcut is ALT+S. 

, ,  
Controls for zoom. Pressing the plus will zoom in on the image. If 
the enlarged image does not fit the screen two sliders will appear. 
The mouse wheel can also be used for zooming. The minus will 
zoom out. The zoom factor is displayed right of the minus. The 
maximum allowed zoom factor is 1000%. 

 or  
Activate or de-activate edit mode. If yellow, editing is activated. If 
grey it is not active. 

 or  
Edit the information field. Each fingerprint file contains an 
information field. Upon pressing the button, a metadata editor is 
opened (see §5.1 for details). If the button is grey you need to 
activate the edit mode first. 

 or  
 

Delete the region of interest and all key points inside. If the button is 
grey you need to activate the edit mode first. 

 or  
Change indicator. If the annotation has changed the button 
becomes yellow until the fingerprint is saved. 

 
A field, which will show instructions or the number of key points 
during annotation. The field is larger in the application. If a message 
is shown, the field will be yellow. 

 

These three buttons help the user to control the process where the 
image is reduced to either pattern or the rest. With the left button 
you indicate that you want to point out pattern pixels. With the 
middle button you indicate pointing out non-pattern pixels.  
 
With the right button, you ask I

3
S to classify all pixels in the region of 

interest as pattern or non-pattern, based on your example pixels. 
The pattern pixels are shown as a partly transparent overlay on top 
of the image. 

 

With this slider you can change the transparency of the pattern 
overlay to be able to judge better whether the separation into 
pattern and non-pattern is to your satisfaction. 

 

4.3 Pattern annotation 

 The reference points 4.3.1

For the algorithm it is essential to get a first indication how two images roughly match. For this step 
the reference points are used. If the reference points are not annotated, I

3
S requires you to annotate 

these first. Before you start, activate edit mode first ( ).  
 
The reference points are annotated by clicking with the left mouse button the three (or two) reference 
points in a fixed order. Do not mix-up these reference points as this will obstruct proper recognition! If 
you click a wrong position you can undo this by clicking with the middle or right mouse button near 
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the wrong location. The text field will show in bright yellow which reference point to annotate. In the 
example in Figure 4-17 the text field shows ñPoint out edge of outer scale as third reference pointò. 
 
You are entirely free to choose your own reference points. Give them proper names which make 
sense and which are not easy to mistake for each other (names like ref1, ref2 and ref3 are not a 
good idea). Further, the reference points should be clearly visible in all images and in an ideal case 
they should form a triangle with 60 degree angles (although this is usually not possible). 
 
In case you can guarantee a perpendicular viewing angle you may consider using two reference 
points. The advantage of two reference points (compared to three) is that sometimes it is hard to 
annotate three reference points consistently. The disadvantage of two reference points is that it is not 
possible to correct for deformations which occur when not viewing the animal under a perpendicular 
angle. 
 
Below we will address both the case for three and two reference points. 

 Three reference points 4.3.2

For newts, we chose the following three reference points: 
1. Right base of head. 
2. Left base of head. 
3. Base of tail. 

 
 

 

Figure 4-17: Annotation of the last reference point with instructions 
in the yellow text field. (Image source: Univ. of Eastern Finland) 

 
Figure 4-18 below shows these three points. The third requires some extra attention as for this point 
sometimes there are multiple options. Pay special attention to consistent annotation of this reference 
point. 
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Figure 4-18: The three reference points for a newt. (Image source: Univ. of Eastern Finland) 

 Two reference points 4.3.3

In case of only two reference points we use the tip of the head and the base of the tail when 
annotating newts. The image below shows their location. 
 

 

Figure 4-19: Newt image with two reference points. 

 Region of interest 4.3.4

After annotation of the (two or three) reference points, you have to annotate the region of interest. 
This region is the area where the key points will be extracted automatically. Just click in the image 
and green lines will appear. You finish by clicking on the start position. The polygon will be closed 
and you are ready for the next step: segmentation.  
 
During annotation of the region of interest, you can undo your latest action by clicking the middle or 
right mouse button (or using CTRL-Z and CTRL-R). I

3
S will not allow self-intersecting regions of 

interest. 
 


























